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Architecture Changes

Modularity
In al prior versions of TruckSim, custom math models were created for multibody models of
interest, such as a motor vehicle with a front independent suspension and solid-axle rear

suspension towing a two-axle trailer (both solid-axle suspensions), with a code such as
| S SS. TruckSim 2017 included custom solvers for 84 distinct models. On Windows, each

model was handled with separate solvers for 32-bit and 64-bit operation.
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Version 2018 introduces the outcome of afour-year project to redo the architecture of VS Solvers
to support more user-selectable options. New methods for connecting multibody models were
developed that maintain the fidelity and computational efficiency of past versions, while
supporting the options to install parts of the model at runtime. The result is that TruckSim 2018.0
includes just two Windows vehicle solvers: t rucksi m 32.dl 1 and t rucksi m 64.dl 1.
Each solver includes modules for al types of motor vehicles, trailers, and suspensions that were
supported in past versions. The modules are used only if heeded for each simulation.

The number of solvers is also reduced for Linux and all real-time systems. Most have a single
solver; those that support both 32-bit and 64-bit dynamic librariesinclude one solver for each.

Using version 2018 is the same as using prior versions for most activities. The same parameters,
state variables, outputs, imports, etc. exist in the new version, with the same keywords, user
interface, and datasets. The Echo fileis not affected by the modularity.

The differences that will be seen with this release are:

1. Most simulations run faster. The speed improvement is more significant for vehicles with
trailers.

2. Differencesin simulation results exist, but are very small. The differences are mainly due
to improvements in the suspension and steering kinematics and are unrelated to the
modul arity.

3. Itisnow possibleto simulate almost any highway heavy truck combination. Although the
TruckSim GUI is limited to vehicle combinations with two trailers, version 2018 includes
examples showing how trailers and axles can be added as needed to obtain very large
configurations.

More details about the changes related to modularity are provided in the memo Modular Vehicle
Models in Version 2018, available from the Help menu: Help>Release Notes>TruckSim 2018:
Modular Vehicle Models.

Longer Names for Output Variables

The VS output file format was introduced in 2014 as an aternative to the legacy ERD file format.
In version 2017, support was added for comma-separated variable (CSV) text files that can be
opened by Excel and other spreadsheet programs. ERD files restrict the short variable names used
as keywords to 8 characters, CSV and V Sfiles support longer names.

The VS Solvers now make use of longer names in order to provide consistent naming of variables
when there are many instances (e.g., more than nine ADAS sensors, more than ninetires, etc.). If
the output variable has a name longer than 8 characters, VS and ERD output files include both the
long name and a name limited to 8 characters. VS Visuaizer and the VS/ERD File Utility now
recognize both the SHORTNAM and the NAME keywords when reading ERD files. Therefore,
datasets for plots and animation from older versions that specify names with the 8-character limit
are processed correctly.

If the ERD format is used, the header now includes both long and legacy names. The keyword
SHORTNAMhas been used since the ERD format was published in 1984. VS Solvers from version
2018 provide these names, and names that may be longer, using a new keyword NAME. Because
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the SHORTNAM information is still written to the ERD header, legacy utility programs that
support the ERD format should till operate correctly.

Documentation files that list outputs (as obtained with the View button on the Run Control
screen) show both versions for names when the full name has more than 8 characters, as do the
V'S Browser screens used to view and select outputs, such as Plot Setup, 1/0 Channels. Export,
and 1/0O Channels: Write.

Binary Table Files

Tabular data used in Configurable Functions have traditionally been provided in text Parsfiles. In
some cases, very large tables are needed to represent road surface properties. A result is that the
time needed by the VS Solver to read the input Parsfiles can be excessive. For example, some
datasets used in driving simulators might take more than 20 minutes to load when the tables are
provided in text form.

TruckSim 2017 included some example simulations that took place in Mcity, with the ground
geometry provided by 2D tabular data read from an ERD binary file. In this case, the time to load
the binary datais about 0.15s, reduced from about 20 minutes for atext version.

In version 2018, an API (vs_t abl e. dl I ) has been developed to support this type of usage,
with utilities for creating binary table files (. vst b) that are well-suited for reading large tablesin
ashort time.

An API (vs_out put . dl |') has also been developed to support the reading and modification of
V'S Output files (. vs) that will aid the user in modification of VS Outputs for use by other
programs or processes.

Full Support for User Defined Differential Equations

VS Commands were introduced in TruckSim in 2007, including the option to add ordinary
differential equations (ODEs) with the command EQ DI FFERENTI AL. The ODEs added with
VS Commands have been numerically integrated with the same methods as the built-in ODEs.
However, some features were not fully supported.

Starting in version 2018.0, user-defined dtate variables are listed in machine-generated
documentation files (accessed with the View button on the lower-right corner of the Run Control
screen), the same as built-in state variables.

User-defined state variables are now listed in the End Parsfile (along with built-in state variables)
to support a new run that continues an existing simulation run.

Error and Range Checking in VS Command functions

Formulas used in VS Commands and other inputs can make use of about 45 built-in functions. In
past versions, functions such as sqrt, pow, si n, cos, were handled by passing the arguments
directly to native C library functions (as declared in mat h. h). A few of these functions have
range limits. For example, the function asi n requires that the argument be within £1; the
function sqrt requiresthat the argument not be negative.
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In version 2018, two levels of range checking are added. Functions that have known ranges now
check the argument. If it goes outside the range, the argument is changed to the limit and then the
function is applied. For example, asi n(-1. 01) is evaluated as asi n(- 1. 0) . As ancther
example, sqrt (- 0. 123) isevaluatedassqrt (0. 0) .

If results show a math exception (nan or i nf, indicating “not a number” or “infinite,”
respectively), an error is generated and the formulais shown.

In past versions, the formulain the VS Command would return anan or i nf , but there would be
no reporting. In many cases the VS Commands were not critical, so users were unaware of the
issue.

Writing Output Variables for Optional Parts

TruckSim has many output variables that are associated with the basic parts of the multibody
model, such as sprung mass motions, tire kinematics and forces, suspension deflections and
forces, etc. These variables always exist, and can be plotted, applied to animate auxiliary objects
(e.g., force arrows), and used in VS Commands. The variables are activated for writing to file by
referring to them in datasets from the Plot Setup, Animator Reference Frame, and 1/O
Channel Output libraries.

The math model also has many parts that are optional (e.g., reference points) and also have
associated output variables. The output variables for the optional parts are added to the model
when the parts are defined automatically by linking to datasets that define the properties of the
parts.

The default behavior for VS Commands that create new output variables was changed in v2018 to
define the variables, but not activate them for writing to file. When the checkbox “Write all
outputs’ on the Run Control screen is not checked, outputs are activated for being written to the
output file only if they are used in animations or plots. Of course, they still exist, and may aways
be used in VS Commands and/or exported to other software.

In some ADAS scenarios, there can be tens of thousands of output variables associated with
moving objects and detections by ADAS sensors, so this behavior could result in very large
output files. The new behavior supports the creation of much small files, and sometimes faster
simulation.

Model Features

New Vehicle Configurations Supported by Modularity

As noted earlier, TruckSim 2018.0 includes just two Windows vehicle solvers
trucksim32.dll andtrucksi m64.dl|. These support all vehicle configurations that

were possible in prior versions, plus configurations that were never available in earlier versions.
For example, trailers can have any combination of suspension types.

The TruckSim GUI supports motor vehicle lead units with up to five suspensions; trailers with up
to four suspensions; dollies with up to three suspensions; and combinations with up to two trailers
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(where each trailer may include a dolly). The suspensions can be generic/independent or solid
axles, steered or un-steered.

Using Generic screens in the GUI, advanced users can assemble combinations with many more
trailers. Trailers can also be assembled that have more than four axles.

The TruckSim 2018 solvers support up to 32 units (lead unit plus up to 31 trailers and dollies),
and up to 128 suspensions.

Performance Based Standards (PBS) are used as a scheme for regulating truck configurations
acceptable on national highway systems in a number of countries, with the main development
taking place in Australia. Mechanical Simulation used to license a PBS package, with a set of
large vehicle configurations for use to certify vehicles with PBS tests. Starting with version
2018.0, the PBS capabilities are a standard part of TruckSim. All vehicle configurations that were
previoudy available in the PBS package can be handled with TruckSim 2018. Further, the
initiali zation methods have been improved, so the simulation setups have been smplified for this
release.

Details of the modules included in TruckSim are provided in the memo Modular Vehicle Models
in Version 2018, available from the Help menu: Help>Release Notes>TruckSim 2018:
Modular Vehicle M odels.

Vehicle Dynamics

Aerodynamics

Aerodynamic dlip is the angle between the absolute wind vector and the vehicle velocity vector.
The point in the vehicle used to define the velocity vector was changed from a point fixed in the
sprung mass to the instant location of the total mass of the lead unit. This was the original intent
years ago, but the methods used to build the model required an approximation.

Brakes

The wheels on the vehicle now include a bearing friction (keyword = MY_FRI CTI ON) that is
automatically added to the brake torque applied to the wheel. The friction torque is applied even
when the brake system is not in use, providing more redlistic behavior in scenarios where the
vehicleisat rest and neither the brake system nor powertrain are connected.

Generic Suspension Model

Independent suspensions have been extended to include 2-D tables for kinematics and
compliances, with the two independent variables being the jounce on the current and opposing
side. This extension was made to support the testing needed for twist-beam suspensions.

The suspensions have been renamed “generic” because the two sides of the suspension are not
completely independent when the 2-D tables are used. However, the vehicle code still uses the
letter ‘1, asin the code | _S for a vehicle with an independent (generic) front suspension and a

solid-axle rear suspension.
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Powertrain

Shift duration can now be set separately for upshifting and downshifting of an automatic
transmission, with different values for each gear position (new keywords: T_SHI FT_UP and
T_SHI FT_DOWN). In support of backward compatibility, the default values for the new durations
are—1, in which case the default duration is used (the default duration keyword is T_SHI FT).

Another improvement in the powertrain model is that the AVL Cruise screen now supports up to
18 gears shift schedules (it was previously limited to seven gears shift schedules).

Steering system
TruckSim now includes al steering system options that existed in CarSim, including power
steering and open-loop torgque input at the steering wheel.

The steered suspensions in TruckSim now include the full 3D geometry and effects of an inclined
kingpin axis. This has been used in CarSim for years, but was not installed in TruckSim because
the equations are more complex, and the simulations ran slower for lead units with many axles,
especially in the case of solid axles. In the modular setup, the more complicated equations are
used only if needed, and the overall simulation time is usually shorter because simpler equations
are used for the un-steered suspensions.

The steering system supports column-assisted power steering. The assist torque is applied to the
pinion or input gear.

Suspension output variables

Three suspension kinematics outputs on each suspension side (Di ve_L1, SusX L1, SusY_L1,
...) are added. They are wheel knuckle dive angle, wheel longitudinal displacement, and latera
displacement from the design location based on the sprung mass coordinate system and can be
useful to correlate with real K& C test data.

Tires
The effective rolling radius is now extendable from a constant (specified on the Tire screen) to a
time variable by importing the datafrom VS Commands, Simulink, etc.

Two tire kinematics output variables for each tire (YawK L1, Rol | WK L1, ...) are added.
They are the Euler yaw and roll angle of the wheel knuckle (the Euler sequence is yaw->pitch-
>roll), which are inputs to the VS ST tire models.

Vehicle configuration parameters

Information about the vehicle configuration is available for use in VS Commands. Properties are
written in the Echo file with keywords VEH CLE_NAXLES (total number of axles),
VEHI CLE_NUNI TS (total number of vehicle units), and VEHI CLE_AXLE_MAP(u) (number of

axles for vehicle unit u). These values are read-only.

GPS Outputs

Output variables for GPS latitude and longitude in past versions were based on parameters for
reference latitude and longitude for global X-Y coordinates of (0,0). Three new parameters were
added for version 2018 in support of large changesin global Y coordinates. These are reference X
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and Y coordinates corresponding to the reference GPS latitude and longitude, and a limit of Y
change that will trigger a new GPS calibration.

Paths and Roads

The maximum number of reference paths was increased from 100 to 200. The maximum number
of supporting tables such as LTARG (lateral offset) and SPEED TARCGET (target speed for ego
vehicle or moving object) was also increased to 200.

When working with external software that provides road surface information, there was
previoudy a check to ensure that all information was provided. For each point of interest, the
import variables are Zgnd, Mux, Muy, Dzdx, and Dzdy. The error-checking has been removed
in support of setups where Zgnd is provided but other variables are intended to keep interna
values.

ADAS (Sensors and Moving Objects)
Many improvements have been made involving the ADAS sensors and moving objects.

Optional writing of output variables

In some ADAS scenarios, there can be tens of thousands of output variables, so this behavior
could result in very large output files. As mentioned earlier, the default behavior was changed for
version 2018; the outputs are not activated by default. When the checkbox “Write all outputs’ on
the Run Control screen is not checked, outputs are typically activated by using them in
animations or plots. This means the output files for ADAS simulations in version 2018 may be
significantly smaller, and the simulations can run faster.

Moving Objects
The maximum allowable number of moving objects was increased from 99 to 200.

More support has been added for using moving objects to represent traffic vehicles. A speed
variable V_OBJ_0 has been added to provide a built-in (optional) differentia equation for
calculating station. A parameter OPT_SPEED OBJ was added with three options for handling
speed: 0 -> don't use speed to calculate station or X-Y coordinates, 1-> integrate V_OBJ_o0 to
obtain station, and 2-> integrate V_OBJ_o0 to obtain station and also use a new wheelbase
parameter L_WB_OBJ to calculate heading angle with a differential equation that simulates
vehicle offtracking. When offtracking is enabled, the motions of the moving objects resemble the
behavior of rea vehicles even in severe low-speed turns. When OPT_SPEED OBJ is zero, the
variable V_0OBJ_oiscalculated using finite differences.

X and Y coordinates for added for the four corners of rectangular objects. For cylindrical objects,
the four points are for the front, right, rear, and left.

GPS latitude and longitude were added as output variables for all moving objects.

Information about an object shape is always used if thereis at least one ADAS range and tracking
sensor in the simulation. A parameter named OPT_SHAPE _OBJ was added to also use shape

information for moving objectsin case there are no ADAS sensors.
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ADAS Sensors and Detections
The maximum allowable number of ADAS sensor was increased from 20 to 99.

A range-limit parameter RANGE LI M T_SENSOR was added to the sensor model. It is used to
eliminate calculations for moving objects that are guaranteed to be out of range for a sensor; this
can reduce the simulation time noticeably when there are many objects and/or sensors.

A similar method is used to eliminate moving objects based on bearing angle, using the existing
field of view parameters.

Another parameter was added for sensors in genera. When the new parameter
OPT_ALTERNATE_SENSORS is given a non-zero value, only one sensor is updated each time
step. The sensor being updated aternates among all sensors. For example, if there are four
sensors, each one is updated every fourth time-step. In nearly al cases, the parameter can be
safely given a nonzero value; the default value is 1. When the value of this parameter is zero, all
sensor detections are calculated every time step, as was done in past versions.

The new parameters RANGE LI M T_SENSOR and OPT_ALTERNATE_SENSCORS can speed up
the smulation, with the difference being more significant for large numbers of moving objects
and sensors. For atest case with 20 sensors and 99 moving objects, the cal culation decreased by a
factor of 10 (90% reduction in computation time)!

The connection to the main VS Solver was redone for 2018 to provide better support for VS
Commands and Events. Past versions did not support changes to path or road 1D numbers for
moving objects after the run initialized; version 2018 provides full control for changing properties
with Events. In past versions, initialization was not complete at T=0; now it is.

Output variables for detections all involve the connection between one sensor and one moving
object. Each time a sensor or object is created, output variables for all potential detections are
created. In past versions, output variables for detections could not be used in VS Command
equations until both the sensors and moving objects had been defined. TruckSim 2018 adds a new
sensor parameter N_M N_DETECTI ONS that causes the DEFI NE_SENSORS command to create
aminimum number of sets of detection output variables. If left at the default value of 1, each time
a sensor is defined, the output variables for one detection will also be created. This feature
enables sensors to be created before moving objects, as is the case in the TruckSim GUI if the
sensor datasets are linked to a vehicle dataset.

New detection output variables were added: the global X and Y coordinates for the left and right
edges of a detected object.

A new dgorithm was implemented to control occlusion of objects. In TruckSim 2018.0, a
parameter for each sensor OPT_LEGACY_SENSCR can be set to 1 to disable the new algorithm

(the default is 0). This new algorithm provides increased accuracy in certain edge cases. These
edge cases are showcased in the “* TS 2018 — Sensor | nprovenents” category. The

yellow field notes panel for each of the three examples gives a detailed explanation of the
improvements being demonstrated.
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VS Visualizer

The VS Visualizer Tool

A new option Export Video has been added (available from the File menu) to create an AVI
(audio-video interleaved) file that can be dragged into Microsoft PowerPoint® or viewed with
Windows Media Player and other video players.

An option has been added to specify the same scaling for the X and Y axes. Thisis enabled with a
checkbox on the Plot Setup screen. This option is typically used for plots of trajectories of points
on the vehicle and/or moving objects, such as offtracking plots.

When VS Visualizer is launched by clicking the Plot button on the Run Control screen, it skips
animator assets to load more quickly. This helps diagnose runs that crashed, which sometimes
cause the animator part of VS Visualizer to also crash. Also, the load time for VS files has been
reduced dramatically, especially for larger files.

When VS Visuadizer is showing plots with overlays from two or more output files, dragging new
variables from the Data M anager pane into a plot pane adds the variables from all open files that
contain those variables.

The default plot format was changed to match the style set in the Plot Format datasets shipped in
recent versions of CarSim, providing a more consistence appearance covering plots set up from
the database and plots created interactively.

Animation Resources

The amount of animator resources provided in TruckSim has been greatly expanded. All current
vehicle shapes for CarSim, TruckSim, and BikeSim are now provided in all three products, in
support of ADAS examples with a variety of traffic vehicles. The Resour ces/ Ani mat or
folder in Tr uckSi m_Pr og has animator assets organized into five top-level folders:

1. 2D HUD I cons

2. 3D _Shape_Fil es

3. Audio Al VS

4. Road _Materials

5. Deprecated Assets

Older versions of the software had many example shapes that used older formats as required by
the legacy SurfAnim program. Shape files have been upgraded to take advantage of more modern
options, such as compression and lighting/shadow support.

The folder Depr ecat ed_Asset s contains assets that were used in 2017 but are no longer
used. It is provided to in order to support databases imported from older versions.

This release has other new features, such as aternative drivers (male and female, Caucasian and
Asian) and more traffic signs.
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New Tools

Version 2018 will introduce several new interactive tools for assembling scenes, paths, and road
surfaces for ADAS examples. Theseinclude:

e VS Scene Builder uses drag-and-drop tiles to rapidly assemble scenes with 3D
animation assets. The tool also provides click and drag options for creating VS
reference paths to use with TruckSim close-loop controllers and moving objects.
Accessthistool from the TruckSim Tools menu.

o The Atlas web server (atlas.carsim.com) introduced in TruckSim 2016 was extended
to the third generation to support the new import tool and to provide elevation data
associated with downloaded paths.

e A new plug-in for the ADAS RP application. The plug-in leverages the HERE map
database for detailed road information with an option to query elevation data using
Google viathe car si m comAtlas web service. It combines horizontal coordinates
from HERE with Z coordinates from Google to convert real-world map information
into path and road datasets that can be used within TruckSim.

These new tools generate JSON (JavaScript Object Notation) text files that can be imported to
TruckSim with the new Scene: External Import screen described below.

Graphic User Interface (GUI)

Scene: External Import Screen
A new library Scene: External Import was added to support import of path, road, and animation
datasets from Atlas, ADAS RP, and VS Scene Builder. Datasets from this library are linked to
datasets in the Road: 3D Surface library.

The imported datasets are unique in having both path/road data for the VS Solver, aong with
supporting 3D animator assets.

Preferences Screen

The Preferences screen was modified to fix some existing problems and support new features
such as the increased number of animation resources. Past versions of the screen included a few
blue links for default datasets to be used for Plot Formats and for shapes used to show targetsin
ADAS applications. These links led to problems in some cases when transferring data with CPAR
files, so they were removed for versions 2018. Here are some changes that were made:

1. A checkbox was added to support a new option: “Perform batch run updating when
deleting or renaming Run screen.” Thisis helpful for users who make batch runs with the
Batch Runs tool. When this is active and a dataset from the Run Control screen is
deleted or renamed, the Browser scans all datasets in the Batch Runs library and fixes
invalid references to the old name

2. A Secondary Resour ces field was added for specifying a location for VS Visualizer to
find additional assets. Users can now add a folder with custom assets.
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3. Checkboxes for selecting the deprecated tools WIinEP and SurfAnim were removed;
TruckSim 2018 does not support those tools.

4. The blue link for a default plot format has been removed. New versions have links to a
plot format for every Plot Settings dataset. Imported plot datasets without a specified
plot format will use the default from VS Visualizer.

5. Thebluelinksfor default cube and cylinder used for ADAS-related animations have been
removed. The link to 1x1x1 cube or cylinder is now hard-coded. (It still applies only
when abox is checked to view the pure target shape.)

Moving Object Screens
The Multiple Moving Objects screen was changed to support new features. A wheelbase

parameter and option were added in support of offtracking. The VS Commands that are written
automatically make use of the new speed variable V_0OBJ_. EQ DI FFERENTI AL commands

that were used in past versions are no longer needed and are no longer written to the Parsfiles.

When the checkbox Show target? is checked, a rectangular or cylindrical shape is shown by VS
Visualizer if a simulation using the dataset is viewed. In past versions, the 3D shape file was set
in the Preferences screen. As noted in the previous subsection, the database now automatically
uses a 1x1x1 cube or cylinder shape.

The Single Moving Object (Custom) screen was also changed to support the new speed
variables and remove some automatically written VS Command equations.

Miscellaneous Changes
Here are some other changes to the GUI.

¢ Many of the miscellaneous yellow fields are now resizable to provide a quick view of
the contents without scrolling.

e The Tools menu adds support for MATLAB 2017b.

o ThePlot Setup screen was modified to remove a checkbox that only applied for the
obsolete WIinEP plotter, and to add support for the 1:1 X-Y scaling that is now
supported by VS Visualizer.

e The Powertrain: Shift Schedule screen has two new fields for the upshift and
downshift duration (keywords. T_SHI FT_UP and T_SHI FT_DOWN). If the new

fields are blank, the default duration (legacy) from the Powertrain: Transmission
(18 Gearsor CVT) screenis used.

o Yellow fields were added to the Brake System screens to support the new bearing
friction parameters (keyword = MY_FRI CTI ON).
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Database

New Examples

Examples introduced in versions 2017.0 and 2017.1 have been moved into other categories.
Examples that were introduced in 2018 have categories whose names begin with“* TS 2018”.

1. TS 2018 — Camera Sensors. Highway Lane Detection (Simulink). This example shows
the Camera Sensor capability of VS Visualizer when used with the Computer Vision
System Toolbox and Image Processing Toolbox from MathWorks.

2. TS 2018 — New Animator Assets. A few runs were made that show some of the new
animator assets added to CarSim.

3. TS 2018 — Performance Based Standard (PBS). PBS test procedures have al been
updated to make use of new features.

4. TS 2018 — Power Steering. Examples show different options for using the new power
steering features.

5. TS 2018 — Scene Import. New datasets exercising the new Path import method show
scenes, paths, and roads imported from ADAS RP, VS Scene Builder, and Atlas.

6. TS 2018 — Sensor Improvements. |mprovements were made in the occlusion behavior of
ADAS sensors. Some examples show cases where better behavior is simulated.

7. TS2018-Tire Models. Runs make use of tire test obtained provided by SAE.

8. TS 2018 — Very Large Vehicles. Examples show the capabilities of the TruckSim
modular architecture to build custom vehicle configurations.

9. Vadidation of Vehicle Data — examples were added with ssimple tests that are helpful for
evaluating new vehicle datasets, such as a vehicle at rest on aflat level surface. These are
described in anew Tech Memo “Validation of VS Vehicle Models.”

Changes Made to Existing Examples
Nearly all links to animator resources were changed to work with the new organization of
animator resources mentioned earlier.

Animator sound sets were removed for most example. Although audio is an essentia feature of
TruckSim when used in driving simulators, it is more of a distraction when using the tool in other
applications, especially when the sound samples are not customized for the specified vehicles. An
example run in the category “VS Visualizer Examples’ still shows how audio can be used for
engine, wind, and tire sounds as part of the video generated by VS Visuaizer.

Documentation Updates

Documents from the Help Menu
The following documents have been added to the Help menu:
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8.

ADAS RP Plug-In (Tech Memo)

Twist Beam Model with 2D Tables (Tech Memo)

Scene Externa Import (Screen Documentation)

The Design Load Condition in CarSim and TruckSim (Tech Memo)
Validation of VS Vehicle Models (Tech Memo)

V'S Scene Builder (Tools submenu)

3DS Max OBS OSG Export Setup (Tools submenu)

V'S Output/Table API (Reference Manual)

The following Reference Manuals have been updated:

9.

10.
11.
12.
13.
14.
15.

System Parametersin VS Solvers
VS AP

V'S Browser

VS COM Interface

VS Commands

V'S Solver Programs

VS Visudizer

The following Screen documents have been updated:

16.
17.
18.
19.
20.
21.
22
23.
24,
25.
26.

27.
28.
29.

ADAS Sensors and Moving Objects
Animator: Camera Setup

Animator Shapes and Groups

Animator Sounds

Animator: Wheel Arrows and Other Indicators
Custom Forces and Motion Sensors
External Models and RT Systems

Plot Screens

Powertrain System

Preferences

Run Control Screen (Home)

Setting Up Import and Output Variables
Steering System

Tire Models
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30. Vehicle Screens and Outputs
The following technical memos have been updated:
31. Example: Camera Sensors
32. Example: Running Multiple Vehiclesin Simulink
33. Making Advanced Procedures with VS Commands
34. Numerical Integrationin VS Solvers
35. PBS Safety Standard Testing Using TruckSim
36. Vehicle Dynamics Terminol ogy
The following documents involving RT systems and driving simulators have been updated:
37. Concurrent RT Guide
38. dSPACE RT Guide
39. LabCar RTPC Guide
40. NI RT Guide
41. RT Lab Guide

Machine-generated documents

The machine-generated documentation for output variables includes more details for some
variables, such as coordinate systems, details of definitions, etc. If the name of the variable is
more than 8 charactersin length, a shorter nameis also listed that can aso be used.

The machine-generated documentation for state variables now include ODE state variables that
were created with the EQ DI FFERENTI AL command.

Values of gtate variables created with the EQ DI FFERENTI AL command are now listed in the
End file, in support of continuation runs.

The math models within the VS Solvers include some variables that were introduced in machine-
generated code as independent state variables that are then constrained to be agebraic functions
of other state variables. Past versions listed the constrained state variables in machine-generated
documentation (accessed with the View button in the lower-right corner of the Run Control
screen), with the misleading implication that they could be given initial condition values. In
version 2018 they not listed.

Bug Fixes and Errata

Miscellaneous

1. Theocclusion of moving objects that are detected by ADAS sensors was based on sorting
the objects based on distance from the sensor. The simple method used in past version did
not always work as intended in some cases where targets have drastically different sizes.

14717



2. Tireforces and moments at the center of tire contact (CTC) may be imported. However,
if the selected tire model was an external model such as TASS MFTyre or COSIN/Ftire,
the import variables were not used in the multibody model, but were added to the force
and moment output variables. This was misleading. In version 2018, these imports are
ignored completely for external tire models (OPT_TI RE_MODEL > 8) and do not
produce confusing outputs.

3. Screensfor tabular tire data have an option for Legacy Tire (2D, absolute dlip, from
zero). When sdlected, the tabular data should use only positive values of dip.
However, if asymmetric data were entered that started with negative dlip angles, there
was no error reporting. This has been fixed. As a result, there may be cases where
datasets from previous versions will now generate errors.

4. 5-axlevehicleswith 1- or 2-axle driven powertrains had incorrect drive torque calculation
due to assigning wrong axles’ wheel speeds. This has been fixed.

5. Powertrain may be selected on the lead unit which has more than five axles. However,
the powertrain model didn’t provide proper calculations for a vehicle unit with six or
more axles. In version 2018.0, the powertrain systems are applied on the first five axlesiif
the vehicle unit has more than five axles.

6. Texture render issues which occurred when viewing Mcity scenes in VS Visuaizer's
compatible mode have been corrected.

7. The api-ms-win-crt-runtime*.dll error when using Windows 7 SP1 has been addressed
with v2018.0.

8. Run and CreateAllParfile COM functions failure on locked screen has been fixed. Users
may have to unlock a screen before executing COM functions which would modify
screen data.

9. Compatibility problems with MATLAB 2017aand 2017b have been corrected

Backward Compatibility

Most of the new features involve new parameters and output variables. Old datasets do not use
these features, so backward compatibility is maintained. However, some of the new features
replace older capabilities, making some differences inevitable.

TruckSim 2018.0 will automatically convert databases going back to 7.0 (2007). If you need to
work with pre-2007 datasets (version 6), import into a TruckSim version between 7.0 and 8.1.1
and then import from there into TruckSim 2018.

Output variables for optional parts

As mentioned earlier, the default behavior for VS Commands that create new output variables
was changed in v2018 to define the variables, but not activate them for writing to file. Instead,
they are activated as needed for use in animations and plots (the same as built-in output
variables).
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We have found a few cases where output variables for optional parts (e.g., reference points) are
referenced in old databases for use in VS Visualizer for plotting or animation before the variables
are created. Because the variables were always activated for writing, plots and animations worked
as expected. However, with the new behavior, the variables are not activated because they do not
exist when the relevant Parsfiles are read.

A quick workaround is to activate al output variables for writing to file using the checkbox on
the Run Control screen. However, this can generate unnecessarily large files, especialy when
the smulation involves many optional parts such as moving objects and ADAS sensors. The
recommended fix (used in all 2018 examples) isto make sure links to datasets that define the new
parts (reference points, motion sensors, etc.) are processed before links to datasets that use the
new output variablesin plots or custom animations.

Miscellaneous
1. Simfiles must have a vehicle code in order for the VS Solver to activate the appropriate
modules. This is done automatically when runs are made from the TruckSim GUI. If

running simulations from external software, be sure the Simfile includes the
VEHI CLE_CODE keyword and code.

2. New dynamic state variables were added for hitch deflections (X-Y-Z) and suspensions
tranglations (X-Y). Deflections are typically about 0.5 mm. Although agreement between
2018.0 models and 2017.1 is close (typically the first three or four significant digits), it is
not exact. For more information about these eff ects please see the memo Modular Vehicle
Models in Verson 2018, available from the Help menu: Help>Release Notes>
TruckSim 2018: Modular Vehicle Models.

3. More error handling has been added in recent versions. When using datasets imported
from older versions, especially those prior to version 9, errors might be reported. In most
cases, the errors occurred in the older versions but were not noticed.

4. Variables that were listed as state variables but are not truly independent were removed
from the lists of state variables. For example, road steer variables (SV_STR L1,
SV_STR L2, etc.) are no longer listed. References to these variables are no longer valid.
For example, the steering variables were specified for the linearization examples in
2017.1; they were removed from the linearization examples provided in v2018.

5. Output variables used to support fake shadows for animations in the obsolete SurfAnim
program have been removed from the solvers.

6. One of the output variables instaled by the VS Command
I NSTALL_DRI VER_PREVI EW SENSCRS was renamed for consistency with other
outputs. The old name was X_RdS_ i; the new name is X_Tar gi. Both names are
installed and may be used to activate outputs for writing/export. Both may also be used in
V'S Command formulas. However, only the new name can be used to define plots for VS
Visualizer.
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Note The old name Y_RdS i was intended to be renamed as Y_Tar gi.
However, there was a mistake that was not noticed until the last minute.
Therefore, we have a new name for the X coordinate but an old name for
the Y coordinate.

7. Examples provided in past versions for running the VS Solvers from custom "wrapper
programs’ used the old convention of having a separate solver for each vehicle
configuration (eg., s_s.dll, s_ss.dll, etc) locaed in the folder
Pr ogr ans\ sol ver s\ Def aul t for 32-hit versions and
Progr ans\ sol ver s\ Def aul t 64 for 64-bit versions. Those old wrapper programs
will not work with the new convention of having just two modular solvers:
Pr ogr ans\ sol vers\trucksi m 32. dl | and
Progr ans\ sol ver s\t rucksi m 64. dl | . Any custom wrapper code that used the
old name and locations of the VS Solver DLL will need to be modified, as is done with
the exampl e source code provided in v2018.

8. The default behavior for VS Commands that create new output variables was changed in
v2018 to define the variables, but not activate them for writing to file. (Thisis the same
behavior as dl built-in output variables.) Variables are activated for writing by using
them in datasets from the Plot Setup, Animator Reference Frame, and 1/O Channel
Output libraries.

Be aware that output variables cannot be activated until after they are defined. Therefore,
datasets to create new parts (sensors, moving objects, etc.) must be referenced before the
datasets that will make use of them.

9. The solver now checks for exceptional floating-point values such as NaN (not a number)
a smulation time. When importing a database from an earlier version of TruckSim,
some existing VS commands equations may need to be rewritten. For example, the VS
Commands equations for engine sounds in the 2017.1 database should be changed to use
the ABS function before applying the SQRT function, to avoid producing aNaN value.

Known Issues
1. When working in Windows 10 with multiple monitors that have different DPI settings,
the menus of TruckSim 2018 do not position correctly on at least one of the monitors.
Once a TruckSim menu is activated, the mouse position is offset or wrong until the menu
isdismissed or an item is selected. To avoid this behavior, ensure that the TruckSim pop-
up windows are positioned on the screen where you intend to work.

2. When using dSPACE 1006 and 1005 HIL boards, output names greater than 8 characters
will not be received by VS Visualizer during live animation. Be sure to use short names
on these platforms.
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